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ABSTRACT: A computationally efficient method of non- linear analysis is described for 
reinforced concrete frames. The Crisfield arc- length solution procedure is used together with 
developed line element formulation which takes account of both the material nonlinearities 
and the geometric non-linear effects. 
The resulting method has been found to be more reliable and more efficient than the other 
used methods which relied on load-control and displacement-control procedures. 
Results obtained from the analysis of several frames are compared with test results reported 
in this thesis. 
 
This thesis also describes the evaluation of system safety coefficients for non- linear design of 
reinforced concrete columns and frames using a back-calibration method.  The back-
calibration method was described in several previous papers, and was used to evaluate system 
safety coefficients for continuous concrete beams.  Values for systems safety coefficients are 
proposed for ductile flexural system for systems in which collapse is due to concrete crushing 
and for system in which collapses by loss of stability.  The study of slender frames has shown 
up an inadequacy in the simplified column design procedure of AS 3600 when applied to 
slender frames. 
 
This thesis also describes the Correlation Study between Ground Motion Parameters and 
Damage during Kocaeli Earthquake as stated in section III.  
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SECTION I -   Non-Linear Analysis of Concrete 
Frames Using a Direct Stiffness Line 
Element Approach 
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1 INTRODUCTION 

Concrete structures exhibit distinctly non- linear behavior, especially at levels of loading 
close to collapse. Therefore, correct modeling of the material and geometric non-
linearities is required if accurate estimates of behavior at working load and overload are 
required. The realistic analysis of concrete structures, taking account of non- linear and 
inelastic behavior, is tedious and time-consuming. However, over recent years, the 
increasing availability of high-capacity, low-cost computing facilities have  encouraged 
the development of non- linear analysis procedures (Aas-Jakobson & Grenacher, 1974; 
Bazant, Pan & Pijaudier-Cabot, 1987; Wong, Yeo and Warner, 1988; Sun, Bradford and 
Gilbert, 1992, 1994; Kawano and Warner, 1995) for use with computers. This and further 
development of, and improvement to, non- linear analysis procedures in the near future 
will eventually bring about the introduction and wider use of an accurate non-linear 
methods of design (Warner, 1993). 
 
Element type, solution procedure and the type of non- linearities which has been 
considered by various investigators are shown in Table 1 below. 
 
Table 1: Summary of selected procedures for non-linear analysis 
 

Investigators Year 
published 

Non- 
linearity 

Solution Procedure Element 
type 

Aas-Jakobson & 
Grenacher 1974 Geometric 

& Material 

Load control & 
Displacement control 
( deflection) 

Line 
element 

Crisfield 1983 Geometric 
& Material 

Combined Load & 
Displacement control 
(arc- length) 

Finite 
element 

Bazant, Pan & 
Pijaudier-Cabot 1987 Material Displacement control Finite 

element 

Wong, Yeo & 
Warner 

1988 Geometric 
& Material 

Displacement control 
( curvature) 

Line 
element 
( segmented) 

Sun, Bradford & 
Gilbert 

1992, 
1994 

Geometric 
& Material 

Combined Load & 
Displacement control 
(arc- length) 

Finite 
element 

Kawano & Warner 1995 Geometric 
& Material 

Load control & 
Displacement control 

Finite 
element 

Wong & Warner 
(Present method) 

 Geometric 
& Material 

Combined Load & 
Displacement control 
(arc- length) 

Line 
element 
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Non-linear procedures for the analysis of concrete frames use either a finite element 
formulation or a direct stiffness line element formulation. This thesis describes a line 
element formulation for non- linear analysis of concrete structures. 
 

2 LINE ELEMENT APPROACHES 

 
Direct stiffness line element approaches (Aas-Jakobsen and Grenacher, 1974) discretise 
structures and their components into numerous axial flexural beam elements. The 
property of each element is usually assumed uniform, and dependent on a chosen section 
along the element which is modeled numerically by dividing the steel and concrete into 
layers. The axial and flexural stiffnesses are then calculated and these stiffnesses are used 
to form the element stiffness matrix. In a typical finite-element approach, the structure is 
also modeled by elements, each with numerous layers. However, the terms of the element 
stiffness matrix are formed directly from the properties of the layers at a few sections 
(usually three) along the element (Sun, Bradford and Gilbert, 1992, 1994; Kawano and 
Warner, 1995). 
 
Aas-Jakobsen and Grenacher (1974) described a procedure which uses a geometric non-
linear elastic frame analysis as the main routine to analyze concrete frames. Line 
elements were used to model these structures. Geometric non-linearities within an 
element were taken into consideration by augmenting each linear-elastic element stiffness 
ke with a non-linear geometric element stiffness matrix kg. Jennings(l968) had earlier 
pointed out in his paper on modeling of elastic plane frames that using such a formulation 
to model geometrical non-linearity effects, while including the modification of the 
element axial stiffness due to axial load, failed to include the modification of axial 
stiffness due to bowing (ie. lateral deflection). Material non- linearities were included by 
using a section analysis subroutine which provides flexural and axial stiffnesses of 
elements based on known thrust and bending moments. Uniform elements' with 
properties equal to those at mid-element were assumed by Aas-Jakobsen et al. 
 
A different line element formulation with segmented elements was previously used by 
Wong, Yeo and Warner (1988). The properties of the segments making up an element 
were used to form its element stiffness matrix. This greatly reduces the size of the global 
stiffness matrix, which resulted in a reduction in both computer memory storage space 
and program execution time. However, the use of segmented elements, while increasing 
the computational efficiency, can reduce the accuracy of the modeling of the geometric 
non- linearities. To enable members with significant bowing, for example compression 
members, to be modeled accurately, several segmented elements were used to represent 
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each of these members. Geometric non- linearities caused by bowing within the members, 
with several internal nodes and changing position of loaded nodes, were included by 
updating the position of nodes during the analysis. Thus, members which were least 
affected by geometric nonlinearities, e.g. beams, were modeled using a single segmented 
element. 
 
Both the line element procedures of Aas-Jakobsen et al. and Wong et al. described above 
fail to model the geometric non- linearities accurately unless a large number of elements 
are used per member. This thesis describes a line element procedure which can model 
accurately the geometric non- linearities present in a frame. 

3 PROPOSED METHOD OF ANALYSIS 

 
The development of the computer program has been undertaken in two distinct stages. 
The first stage involved the development of a program capable of giving accurate 
solutions to geometrically non-linear plane frames. While binary-coded programs capable 
of analyzing geometrically non-linear frames are available commercially, the independent 
development of such a program enabled computer source codes to be created for 
subsequent modification to include the material nonlinearity effects. After having 
ascertained that the developed geometric non- linear analysis program was accurate, by 
comparing results with those obtained from published analytic solutions (Frish-Fay, 
1962; Lee et al., 1968), the second stage of adding the appropria te subroutines for 
material non- linearities was carried out. Sections 3.1 and 3.2 below describe the program 
in accordance to these two stages of development. 
 

Program for Analysis Second-Order Elastic Frames 
 
In developing a procedure for the analysis of geometrically non- linear frames, the line 
element formulation of Jennings (1968) was used, together with the arc-length solution 
method of Crisfield (1981, 1983). 
 
Jennings' line element formulation allows for significant change in geometry under 
loading. The same formulation was also been used by others (Meek and Tan, 1983; 
Meek, 1991). With this formulation, it is possible to determine the behavior of a plane 
frame with linear-elastic material properties until its deformed shape bears little 
resemblance to its original configuration (Jennings, 1968; Meek and Tan, 1983). 
 



 4 

This formulation includes two parts which make it well-suited for use with a predictor-
corrector solution procedure such as that of Crisfield. These two parts are (1) a tangent 
structural stiffness matrix which allows the prediction of an incremental load scaling 
factor and the corresponding displacements of the frame, and (2) a secant formulation 
which allows element forces to be determined based on the total displacements in the 
structure predicted using the tangent formulation of (1). Part (1) forms the predictor and 
part (2) forms the corrector for use after each prediction. A predictor-corrector solution 
procedure has also been adopted by Kawano and Warner (1995). 
 
In other words, for each iterative cycle the structural tangent stiffness is used to predict 
the incremental displacements to obtain the latest position of the structure at the end of 
the iterative cycle, and the structural secant formulation is used to determine the forces 
required at the nodes to maintain the frame at this position. After having determined these 
forces, the out-of-balanced forces are determined. These out-of-balance forces are used 
for the next iterative cycle to improve the accuracy of the solution until the solution 
converges to within an acceptable tolerance. 
 
Jennings' formulation takes into consideration all geometrical nonlinearities present in a 
structure and solutions obtained have been found to predict the behavior of elastic 
structures accurately (Jennings, 1968). The geometrically non- linearity effects considered 
in this formulation are: 
?  The change of element lateral stiffness, 
?  The finite deflection of joints, and 
?  The change of element length due to bowing. 

 
Jennings' matrix formulation will not be presented here. It is described elsewhere 
(Jennings, 1968; Meek, 1991). 
 

Modification of program to include modelling for material non-linearities 
 
Jennings' line element formulation accurately predicts the behavior of geometrically non-
linear frames and is most suitable for use as the foundation for the non- linear analysis of 
concrete structures because accurate modeling of the geometrical non- linearities is 
assured. 
 
Solution procedures for non-linear structural analysis problems can be based on load 
control, displacement control or combined load displacement control. Load control 
procedures, while useful for structures subjected to working loads, are not suitable for 
tracing behavior at collapse. Using a displacement control procedure can be inefficient as 
the control displacement parameter needs to be decided before the commencement of the 
analysis. The control displacement parameter must be able to act as a monitor for the 
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stiffness degradation of the chosen structure at all stages of loading, irrespective of where 
in the structure this degradation occurs. For example, for a free-standing cantilever 
column, the degradation of stiffness, indicated by the horizontal deflection at the top of 
the column, is mainly affected by the deformation of the segment at the base. Therefore, 
the curvature of this segment is suitable for use as the control displacement parameter. 
However, it is difficult to use a purely displacement control procedure at one location, 
e.g. a curvature or a deflection, for complicated frames where degradations occurring 
almost simultaneously in several regions. 
 
For example, the yielding in a beam forming part of a multi-storey building does not 
affect the sway deflection as much as the yielding in a column. 
Choosing an unsuitable control displacement results in non convergence of the solution 
procedure. For such cases, an arc- length control procedure can be used. 
 
The arc- length control procedure, which is based on a control parameter in the form of a 
constant 'length' in a multi-dimensional load displacement space. For a structure with 
many degrees of freedom of movement, load-displacement control can be simultaneously 
carried out at all the degrees-of- freedom at each node. It is, therefore, more efficient for 
sensing the occurrence of multiple non- linear events, such as simultaneous yielding in 
different parts of a structure. Hence the arc length solution procedure was selected for use 
in the present program, to trace non- linear behavior, up to, and beyond, the point of 
collapse. Details of the arc- length procedure are given in Appendix A. In the present 
method, the tangent stiffness is updated at the start of every iterative cycle rather than at 
the start of the incremental step shown in Figure A1. 
 
Jennings (1968) mentioned in his paper that a program had been developed to include the 
effect of material non- linearities using his formulation. However, the details of this 
program were not given. It is not known whether this program was developed to analyze  
concrete structures. 
 
Sun et al. (1992, 1994) describe the development of a program which also uses the arc-
length solution procedure of Crisfield. This program uses a finite element formulation 
instead of the direct stiffness line element formulation used in the present approach. A 
program developed by Kawano and Warner (1995) uses a finite element method similar 
to that by Sun et al. but it includes time-dependent effects and utilizes a displacement 
control solution procedure. 
 
The procedure to analyze non- linear concrete frames is illustrated using the flow-diagram 
shown in Figure 1. Terms shown in this figure are the same as those given in Appendix 
A. This figure shows diagrammatically the inclusion of the section analysis subroutine. 
This section analysis routine models sections by using steel and concrete layers. The 
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stress strain relation used is that first described by Warner (1969), with the concrete in 
tension having a relation described by Kenyon and Warner (1993). Unloading paths are 
included for concrete in both compression and tension. Concrete in tension is assumed to 
unload towards the origin, and concrete in compression is assumed to unload with initial 
slope. This is shown in Figure 2. The stress-strain relation for steel reinforcement is 
assumed to be elastic-plastic; steel reinforcements in both tension and compression are 
assumed to unload with initial slope. 
 

Advantages of the Present Approach 

 
The present approach ensures that the geometrical non- linearities are taken into 
consideration accurately in a non- linear frame. Premature buckling for a frame with 
compression members can thus be predicted accurately. 
 
The use of uniform property elements enables finite length hinges to develop in the 
structure during the analysis. The present approach assumes that the property of an 
element is uniform, equal to that of the most critically stressed end-section. This 
assumption is conservative for most elements. Previous researchers such as Bazant 
(1976) and Bazant, Pan and Pijaudier-Cabot (1987) showed that hinges in concrete 
structures are of finite length. Bazant et al. (1987) suggested that the length of hinges 
should be approximately equal to its depth. 
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4 COMPARISONS WITH TEST RESULTS 

 
In order to check the accuracy of the present approach, theoretical results have been 
obtained for some columns and frames used in previous experimental studies. The 
following material properties are assumed in the analysis. Modulus of elasticity for steel 
Es is taken as 2.0E5 MPa and that of concrete Ec as 5050 fcm MPa, where fcm is the 

mean concrete strength. The mean in-situ concrete strength is assumed to be equal to the 
mean cylinder strength. Value of the strain at maximum stress ?cmax is assumed to be 
0.002. The parameter ? ??2 used to define the shape of the concrete stress-strain curve 
(Wamer, 1969) is assumed to be 3.0. Where strength of concrete was determined using 
cubes, the conversion of fcm = 0.8 fcube was used. 
 

Short Columns 
 
Short columns subjected to concentric and eccentric loadings were tested by Hognestad 
(1951) and Hudson (1965). Results from these tests, and predictions from the present 
analysis are summarized in Table 2 and Table 3, respectively. The ratios of the test to 
calculated ultimate loads for the columns tested by Hognestad and Hudson are listed in 
the last columns of these tables. Members with concentric load were analyzed by 
assuming a very small load eccentricity of 1.0 mm. 
 
The average and the standard deviation for Ptest/Pcalc obtained for Hognestad's test 
columns are 0.94 and 0.07, and those for Hudson's test columns are 1.04 and 0.07. 
 
Table 2: Hognestad's tests of short columns 
 

Cross-Section 
Tested 

by 

Slender- 
ness 
l/d 

Speci- 
men 

Concrete 
strength, fcm 

(MPa) 
Width 
(mm) 

Depth, d
(mm) 

Ecc. 
ratio 
e/d 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

7.5 B-6a 28.1 254 254 0.00 2028 1967 1.03 
7.5 B-6b 27.9 254 254 0.00 1868 1989 0.94 
7.5 C-6a 13.9 254 254 0.00 1001 1218 0.82 
7.5 C-6b 10.5 254 254 0.00 898 1052 0.85 

 
7.5 A-7a 36.1 254 254 0.33 1219 1168 1.04 

Hognestad 
(1956) 
group II 

7.5 A-7b 40.1 254 254 0.25 1263 1491 0.85 
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7.5 B-7a 28.1 254 254 0.25 1139 1157 0.98 
7.5 B-7b 27.9 254 254 0.25 1103 1153 0.96 
7.5 C-7a 13.6 254 254 0.25 627 731 0.86 
7.5 C-7b 10.5 254 254 0.25 564 638 0.88 

 
7.5 A-8a 38.1 254 254 0.50 721 823 0.88 
7.5 A-8b 40.1 254 254 0.50 676 842 0.80 
7.5 B-8a 32.4 254 254 0.50 694 764 0.91 
7.5 B-8b 29.4 254 254 0.50 649 730 0.89 
7.5 C-8a 12.5 254 254 0.50 440 463 0.95 
7.5 C-8b 12.5 254 254 0.50 440 463 0.95 

 
7.5 A-9a 35.2 254 254 0.75 396 439 0.90 
7.5 A-9b 35.6 254 254 0.75 406 441 0.92 
7.5 B-9a 32.4 254 254 0.75 418 433 0.97 
7.5 B-9b 30.1 254 254 0.75 398 427 0.93 
7.5 C-9a 13.0 254 254 0.75 325 349 0.93 
7.5 C-9b 11.9 254 254 0.75 291 338 0.86 

 
7.5 A-10a 35.2 254 254 1.25 205 209 0.98 
7.5 A-10b 35.6 254 254 1.25 196 209 0.94 
7.5 B-10a 29.4 254 254 1.25 193 205 0.94 
7.5 B-10b 30.1 254 254 1.25 196 206 0.95 
7.5 C-10a 15.9 254 254 1.25 198 194 1.02 
7.5 C-10b 12.2 254 254 1.25 200 191 1.05 

 
Table 2 -contd: Hognestad's tests of short columns 
 

Cross-S ection 
Tested 

by 

Slender- 
ness 
l/d 

Speci- 
men 

Concrete 
strength, 

fcm 
(MPa) 

Width 
(mm) 

Depth, 
d 

(mm) 

Ecc. 
ratio 
e/d 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

7.5 B-11 a 26.7  254 254 0.00 2224 2436 0.91 
7.5 B-11 b 27.7  254 254. 0.00 2157 2485 0.87 
7.5 C-11 b 14.3  254 254 0.00 1570 1758 0.89 

 
7.5 A-12a 28.6  254 254 0.25 1401 1419 0.99 
7.5 A-12b 34.8  254 254 0.25 1446 1596 0.91 
7.5 B-12a 29.7  254 254 0.25 1348 1447 0.93 
7.5 B-12b 27.7  254 254 0.25 1263 1388 0.91 
7.5 C-12a 15.9  254 254 0.25 1121 1048 1.07 
7.5 C-12b 15.2  254 254 0.25 1023 1026 1.00 

 
7.5 A-13a 36.9  254 254 0.50 979 1070 0.91 

Hognestad 
(1956) 

group III 

7.5 A-13b 33.4  254 254 0.50 934 1012 0.92 
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7.5 B-13a 24.7  254 254 0.50 801 861 0.93 
7.5 B-13b 29.6  254 254 0.50 916 946 0.97 
7.5 C-13a 15.9  254 254 0.50 672 699 0.96 
7.5 C-13b 14.3  254 254 0.50 609 671 0.91 

 
7.5 A-14a 36.9  254 254 0.75 632 720 0.88 
7.5 A-14b 35.2  254 254 0.75 681 712 0.96 
7.5 B-14a 24.7  254 254 0.75 617 640 0.96 
7.5 B-14b 31.7  254 254 0.75 489 691 0.71 
7.5 C-14a 13.5  254 254 0.75 514 498 1.03 
7.5 C-14b 14.3  254 254 0.75 463 511 0.91 

 
7.5 A-15a 35.2  254 254 1.25 391 365 1.07 
7.5 A-15b 33.4  254 254 1.25 351 364 0.97 
7.5 B-15a 26.2  254 254 1.25 329 357 0.92 
7.5 B-15b 31.9  254 254 1.25 376 362 1.04 
7.5 C-15a 13.5  254 254 1.25 322 330 0.98 
7.5 C-15b 14.3  254 254 1.25 331 334 0.99 

        Average 0.94 

        Std 
Deviation 

0.07 

 
Table 3: Hudson's tests of short columns 
 

Cross-Section 
Tested 

by 

Slender- 
ness 
l/d 

Speci- 
men 

Concrete 
strength, 

fcm 
(MPa) 

Width 
(mm) 

Depth, 
d 

(mm) 

EcG. 
ratio 
e/d 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

8 11 24.8 102 102 0.00 267 272 0.98 
8 12 24.8 102 102 0.00 267 272 0.98 
8 13 24.8 102 102 0.00 299 272 1.10 
8 14 24.8 102 102 0.00 264 272 0.97 
8 21 26.9 102 102 0.00 311 300 1.04 
8 22 26.9 102 102 0.00 289 300 0.96 
8 23 26.9 102 102 0.00 309 300 1.03 
8 24 26.9 102 102 0.00 311 300 1.04 
8 31 28.3 102 102 0.00 307 306 1.00 
8 32 28.3 102 102 0.00 311 306 1.02 
8 33 28.3 102 102 0.00 289 306 0.94 
8 34 28.3 102 102 0.00 288 306 0.94 
8 41 25.5 102 102 0.00 289 279 1.04 
8 42 25.5 102 102 0.00 306 279 1.10 
8 43 25.5 102 102 0.00 306 279 1.10 
8 44 25.5 102 102 0.00 307 279 1.10 

Hudson 
(1956) 
Series I 
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8 11 24.8 102 102 0.30 156 157 0.99 
8 12 24.8 102 102 0.30 196 157 1.25 
8 13 24.8 102 102 0.30 165 157 1.05 
8 14 24.8 102 102 0.30 178 157 1.13 
8 21 26.9 102 102 0.30 165 169 0.97 
8 22 26.9 102 102 0.30 196 169 1.16 
8 23 26.9 102 102 0.30 173 169 1.03 
8 24 26.9 102 102 0.30 173 169 1.03 
8 31 28.3 102 102 0.30 200 179 1.12 
8 32 28.3 102 102 0.30 200 179 1.12 
8 33 28.3 102. 102 0.30 178 179 0.99 
8 34 28.3 102 102 0.30 169 179 0.94 
8 41 25.5 102 102 0.30 200 196 1.02 
8 42 25.5 102 102 0.30 200 196 1.02 
8 43 25.5 102 102 0.30 200 196 1.02 

Series II 

8 44 25.5 102 102 0.30 187 196 0.95 
       Average 1.04 

       Std 
Deviation 

0.07 

 
 

Long Columns 
The results from the analysis of long columns are compared with test data in the last 
column of Tables 4 through 11. The average and standard deviation of the ratios of 
Ptest /Pcalc are also given in these tables. The concrete mean strength was assumed equal to 
the average cylinder strength. The reasonably good agreement for the individual 
investigation and the absence of any definite trends with major variables such as 
slenderness, load eccentricity, material properties suggests that the ultimate load of 
hinged columns can be predicted with good accuracy using the present analysis. . 
Members with concentric load were analyzed by assuming a small load eccentricity. 
 
Table 4: Columns tested by Breen and Ferguson (1969) 
 

Cross-Section 
Speci- 
men 

Slender
- 

ness 
L/h 

Concrete 
strength, fcm 

(MPa) 
Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. ratio 
e2/h 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

G1 20 25.6 152 102 0.30 151 169 0.89 
G2 40 25.2 152 102 0.60 48 47 1.02 
G3 50 25.5 152 102 0.75 30 31 0.97 
G4 50 25.5 152 102 0.30 53 52 1.03 
G5 60 28.7 152 102 0.90 29 23 1.28 
G6 50 30.2 152 102 0.30 49 48 1.02 
G7 40 33.4 152 102 0.20 67 76 0.88 
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G8 60 28.0 152 102 0.27 48 50 0.96 
G9 20 27.4 152 102 0.30 147 164 0.90 
G10 10 27.7 152 102 0.30 209 230 0.91 

      Average 0.98 
      Std Deviation 0.12 

 
Table 5: Columns tested by Chang and Ferguson (1963) 
 

Cross-Section 
Speci- 
men 

Slender
- 

ness 
L/h 

Concrete 
strength, fcm

(MPa) 
Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. ratio 
e2/h 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest  / 
Pcalc 

1 31 23.3 156 103 0.07 168 187 0.90 
2 31 35.0 156 103 0.39 69 84 0.82 
3 31 28.9 156 103 0.06 189 229 0.83 
4 31 30.1 156 103 0.38 73 80 0.91 
5 31 32.8 156 103 0.21 123 132 0.93 
6 31 33.6 156 103 0.06 197 250 0.79 

      Average 0.86 
      Std Deviation 0.06 

 
Table 6: Columns tested by Martin and Olivieri (1965) 
 

Cross-Section 
Speci- 
men 

Slende 
r- 

ness 
L/h 

Concrete 
strength, 

fcm 
(MPa) 

Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. 
ratio 
e2/h 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

402-1 40.0 30.0 127 90 0.00 147 157 0.93 
402-2 40.0 24.3 127 90 0.00 125 137 0.91 
412-1 40.0 33.6 127 90 0.21 118 123 0.96 
412-2 40.0 25.0 127 90 0.21 89 102 0.87 
422-1 40.0 34.9 127 90 0.39 93 89 1.05 
422-2 40.0 25.7 127 90 0.39 76 76 0.99 
432-1 40.0 37.3 127 90 0.28 96 113 0.85 
432-2 40.0 26.4 127 90 0.28 93 93 1.00 

      Average 0.95 
Note: Columns with double curvature e1 /e2 = - 0.5 

 Std Deviation 0.07 
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Table 7: Columns tested by Thomas (1939) 
 

Cross-Section 
Speci- 
men 

Slender
- 

ness 
L/h 

Concrete 
strength, fcm 

(MPa) 
Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. 
ratio 
e2/h 

Ptest  
(kN) . 

Pcalc 
(kN) 

Ptest / 
Pcalc 

LC1 14.75 24.27 152.4 152.4 0.00 588 554 1.06 
LC2 20.75 24.27 152.4 152.4 0.00 545 606 0.90 
LC3 23.75 24.27 152.4 152.4 0.01 478 498 0.96 
LC4 26.75 24.27 152.4 152.4 0.01 465 439 1.06 
LC5 26.75 24.27 152.4 152.4 0.05 456 363 1.26 
LC6 23.75 24.27 152.4 152.4 0.04 448 451 0.99 
LC7 20.75 24.27 152.4 152.4 0.04 463 493 0.94 
LC8 14.75 24.27 152.4 152.4 0.03 474 531 0.89 

LC9R 26.75 24.27 152.4 152.4 0.02 360 360 1.00 
LC10 23.75 24.27 152.4 152.4 0.04 374 374 1.00 
LC11 20.75 24.27 152.4 152.4 0.04 418 379 1.10 
LC12 14.75 24.27 152.4 152.4 0.03 438 492 0.89 
PLC1 33.1667 24.27 76.2 76.2 0.06 82 62 1.32 
PLC2 33.1667 24.27 76.2 76.2 0.06 81 63 1.28 

      Average 1.05 
      Std Deviation 0.14 

 
Table 8: Columns tested by Green and Hellesland (1975) 
 

Cross-Section 
Speci- 
men 

Slender
- 

ness 
L/h 

Concrete 
strength, fcm

(MPa) 
Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. 
ratio 
e2/h 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

S1 15 34.4 178 127 0.10 502 556 0.90 
S5 15 33.6 178 127 0.09 621 707 0.88 

      Average 0.89 
      Std Deviation 0.02 

 
Table 9: Columns tested by MacGregor and Barter (1965) 
 

Cross-Section 
Speci- 
men 

Slender
- 

ness 

Concrete 
strength, fcm

(MPa) 
Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. 
ratio 
e2/h 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

A1 27 33.6 112 64 0.20 169 185 0.91 
A2 27 32.7 112 64 0.20 169 186 0.91 
B1 27 29.0 112 64 1.50 33 30 1.10 
B2 27 32.6 112 64 1.50 31 30 1.05 
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      Average 0.99 
note: Columns bent in double curvature, e1 /e2 = -1 Std Deviation 0.10 

 
Table 10: Columns tested by Drysdale and Huggins (1971) 
 

Cross-Section 
Speci- 
men 

Slender
- 

ness 

Concrete 
strength, fcm

(MPa) 
Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. 
ratio 
e2/h 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

D-1-A 31 30.3 127 127 0.20 173 165 1.05 
D-1-B 31 30.3 127 127 0.20 172 165 1.04 
D-2-C 31 29.2 127 127 0.20 177 163 1.08 
D-2-D 31 29.2 127 127 0.20 180 163 1.11 
      Average 1.07 
      Std Deviation 0.03 

 
Table 11: Columns tested by Absel-Sayed and Gardner (1975) 
 

Cross-Section 
Speci- 
men 

Slender
- 

ness 

Concrete 
strength, fcm 

(MPa) 
Width 
(mm) 

Depth, 
h 

(mm) 

Ecc. 
ratio 
e2/h 

Ptest  
(kN) 

Pcalc 
(kN) 

Ptest / 
Pcalc 

D1 23 30.8 150 150 0.423 127 144 0.88 
D4 23 31.2 150 150 0.847 62 71 0.89 
D8 23 31.0 150 150 1.267 44 46 0.95 

      Average 0.91 
      Std Deviation 0.04 

 

Frames 
 
The results from the analysis of simple rectangular frames by the present method and the 
analysis carried out by Chang (l967) are compared with test data in Table 12 for the test 
frames shown in Figure 3. Chang used an inelastic analysis which was applicable to 
simple box frames. The analysis took into consideration both material and geometric non-
linearities. For the present approach, the ratio Ptest/Pcalc ranges from 0.82 to 1.18 with an 
average and a standard deviation of 0.96 and 0.14 respectively. From the approach by 
Chang (1967) for simple frames, the ratio of Ptest/Pcalc obtained by him ranges from 0.73 
to 1.19 with an average and a standard deviation of 0.98 and 0.15 respectively. 
 
The differences between the values from tests and those obtained from the present 
analysis may be due to any of the following: 
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? Variations between the mean test strengths and the in-situ material strengths. In the 
present analysis, they were assumed to be the same. 

? Joint effects on the test loads. 
? Un-intentional restraining effect from the applied loads. 

 
Therefore, comparisons between results from the present analysis with those obtained by 
the analysis by Chang (l967) were carried out. The average and standard deviation for the 
ratio of the ultimate load calculated by Chang to the ultimate load calculated by the 
present method are 0.99 and 0.09. The standard deviation is smaller than the value of 
0.14 obtained earlier for Ptest/Pcalc for the present method. While the analysis by Chang 
gave results comparable to those obtained using the present analysis, the present analysis 
has the advantage of not been restrictive in its application. 
 

5 CONCLUDING REMARKS 

 
An efficient approach for the non- linear analysis of reinforced concrete frames using line 
elements has been developed. This approach was developed by inc luding a routine for 
analyzing material non-linearity into a geometric non- linear solution procedure which 
uses an accurate, existing line element formulation presently used for the analysis of 
geometrically non- linear frames. 
 
Table 12: Test results versus calculated values for rectangular frames 
 

Present 
Method 

Results by Chang 
(1967) 

Frame 
Width/ 
height 

Ptest  
(kN) Pcalc 

(kN) 
Ptest / 
Pcalc 

Pcalc(Chang) 
(kN) 

Ptest / 
Pcalc 

Pcalc(Chang) 
Pcalc (Present 

Method) 

Frames tested by Furlong and Ferguson (1965) 
F-1 21 267 296 0.90 294 0.91 0.99 

F-2R 21 274 333 0.82 298 0.92 0.89 
F-3R 21 177 172 1.03 154 1.15 0.90 
F-4 21 234 224 1.04 211 1.11 0.94 
F-5 16 247 276 0.89 241 1.02 0.87 
F-6 16 200 171 1.17 184 1.09 1.08 

Frames tested by Breen and Ferguson (1964) 
F-1 30 262 222 1.18 227 1.15 1.02 
F-2 30 262 287 0.91 274 0.96 0.95 
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F-3 15 271 250 1.08 227 1.19 0.91 
F-4 15 371 361 1.03 316 1.17 0.88 

Frames tested by tested by Ferguson and Breen (1965) 
L-1 20 167 225 0.74 217 0.77 0.96 
L-2 20 111 121 0.92 139 0.80 1.15 
L-3 20 138 143 0.97 145 0.95 1.01 
L-5 10 189 170 1.11 191 0.99 1.12 
L-6 10 245 287 0.85 299 0.82 1.04 
L-7 10 178 237 0.75 245 0.73 1.03 

 
Average 0.96  0.98 0.99 
Std dev. 0.14  0.15 0.09 

 
The resulting approach allows the modeling of frames which include the formation of 
finite length hinges in region of strength degradation. 
 
Comparison of the collapse loads obtained from the present analysis with tests reported in 
the literature shows that the present analysis gives good estimates of collapse loads. 
 
The approach is a suitable tool for use with non- linear design method. It is at present 
being used to determine the safety requirements associated with using such an analytical 
approach for non-linear design. A preliminary report of this work has been published 
(Wong and Warner, 1997). 
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Commence arc-length increment 
Step, STEP 

Form structural tangent stiffness matrix 
based on the latest properties of elements 

Set CYCLE = 0 

CYCLE = CYCLE +1 

Calculated forces acting on the end of 
elements based on the latest total 

displacement, D. 

Calculated the curvature for the most 
critically stressed section 

K_i = M_i/El_i 

Calculate forces acting at the nodes based 
on the latest total displacement, D 

SECTION ANALYSIS ROUTINE 
K_i==> M_i (updated) 

El_i (updated = M_i (updated)/k_i 

Determine ?_i+1, the load factor at the 
end of the present cycle based on arc-

length, ? i 

Calculate Incremental deflection, d. 
Update total deflection, D 

Check convergence 

STEP=STEP +1 

YES 

NO 

Fig 1: Calculation cycle for a typical step 
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This appendix describes Crisfield’s arc- length solution procedure (Crisfield, 1983) 
 
Figure A1 shows that for a typical iterative cycle i, the incremental displacement di is 
calculated by: 
 

? ?? ?uiiti QDfKd ??? ? ?1  

? ? utiit QKDfK 1
1

1 ?? ???? ?  

TiNi dd 1??? ?  
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Where ? ? ? ?iitNi andf DDKd 1???  is the nodal forces based on the total displacement at 
the end of iterative cycle i. 
 
At the beginning of the step utT QKd 1??  and dNi are known. To obtain di for each cycle 
? i+1 needs to be determined. 
The arc- length constraint equation to ? i+1 is  

? ?
i

T
NiNi

T
NiNi

T
Ti

T
T

i
T
i

T
T
T

ii

la

a

a

aaa

Ddandddd,ddd,Ddd

DDd2d

d2d2

dd

where

0

321

2
433

212

1

312
2

11

?????

???????

??

?

??? ?? ??

 

 
Solving he constraint equation a above gives two value ? i+1; and substituting these values 
into the equation below gives two corresponding values of cos?, say c1 and c2 

? ?1142

1
1cos dd

l i ??
?

?? ??  

If one of c1 and c2 I positive, choose ? i+1 corresponding o the one which is positive. 
However if both are positive, choose ? i+1 closest to ? i+1,lin  given below: 

2

3
,1 a

a
lini ????   

The arc- length ? l is based on an initial guess of? ? , and is obtained from the expression  

TT
T

l
a

dd

?
?? ?  

Where a is the sign of r and Tt
T
Tr dKd?  
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SECTION II -   Non-Linear Design of Reinforced 
Concrete Columns and Frames 

 
 
 



 24 

1. INTRODUCTION 

 
Back-calibration was proposed as a method of evaluating system safety coefficients for 
use in the non- linear, collapse load design of concrete structures by Wong and Warner. 
An extensive numerical study has also been undertaken to obtain appropriate values for 
the non- linear design of continuous reinforced concrete beams (Wong and Warner, 
1998). For ductile flexural members it was found that the system safety coefficient value 
of 
 

                                                  ? system  = 0.68                                                                    (1) 
 
was appropriate. This value can thus be used in the collapse load design equation, 
 

                ? system  wu.rig   ?  w*                                                                (2) 
 
where w* is the design ultimate load, and wu.rig is the collapse load, calculated using a 
rigorous non- linear analysis. 
 
The advantages of moving on from the current section strength design methods to 
collapse load design have also been discussed elsewhere (Wong and Warner, 1997a). 
 
In this report, the back -calibration method is used to evaluate ? system for other structural 
systems, in particular columns and frames, in which collapse may be governed by 
compression failure of the concrete and overall system instability. 
 
To apply the back-calibration method, a structure is first designed according to the 
present code requirements, in this case, AS 3600 (Standard Australia, 1994), to carry a 
prescribed design ultimate load, say w*. A rigorous, non- linear collapse load analysis is 
then undertaken to obtain its collapse load, wu.rig, and the safety coefficient is then 
evaluated as 
 

                                                 
rigu

system w
w

.

*
??                                                                    (3) 

 
The assumption here  is that the same design loads and load combination factors will be 
used to determine w* in both the section strength design method and the collapse design 
load method, so, that design using Eq. 2 gives a structure with about the same safety 
margin as would be obtained from the current design procedures. 
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2. NON-LINEAR VALUES OF SYSTEM SAFETY 
COEFFICIENT FOR ISOLATED BRACED 
COLUMNS 

 
Back-calibration calculations were initially undertaken for 70 slender columns with pin 
supports and equal end eccentric ities as shown in Fig 1. Their cross sections were all 400 
mm x 400 mm. The total amount of reinforcement was 3200 mm2, with a concrete cover 
to centroid of steel reinforcement of 50 mm. Slenderness ratio Le/r of the columns ranges 
from 17 to 121, and three values of end eccentricities e/D of 0.0625, 0.75 and 4.0 were 
used. Here e is the load eccentricity and D is the overall depth of the section. Note that 
the minimum end eccentricity e/D of 0.0625 is comparable to the minimum e/D of 0.05 
specified by AS 3600. The following values were used: a characteristic strength of 
concrete of 32.0 MPa and a mean value of 37.2 MPa, and a steel yield stress of 400 MPa 
and a mean value of 460 MPa. The steel reinforcement is two percent of the gross cross-
sectional area. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As described in Section 1, the back-calibration procedure requires values of w*, the 
design ultimate load, and wu.rig, the accurately determined load capacity, for a wide range 
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of structures. In the normal design situation, w* is known and by trial and error design 
details are found such that for critical sections, ?Mu ?  M*. However, in the present 
investigation we fixed the design details, and then determined both w* and wu.rig for each 
particular structural system. The calculation of wu.rig was carried out using the procedure 
described by Wong and Warner (1997b). 
 
As the calculation of wu.rig does not include long-term effects such as creep and 
shrinkage, the creep factor ?? d (defined by AS 3600 as the ratio of the dead load to the 
sum of the dead load plus live load) used in the calculation of the corresponding w* was 
assumed to be zero. 
 
The system safety coefficients for all the columns investigated are shown as a function of 
their slenderness ratios and end eccentricities in Fig. 2. The enormous scatter in results, 
with ? system ranging from about 0.33 to 0.70, is not unexpected and can be explained by 
the peculiarities of the simplified methods used in AS 3600 for the analysis and design of 
columns. 
 
Considering firstly the highest range of values, which occur for e/h varying from 4.0 
down to, say, 0.75, we note that these all correspond to primary tension flexural failure in 
the mid-depth section of the column. The capacity reduction factor ?  used in AS 3600 is 
close to 0.8 for these cases because ?  for columns slides from 0.6 up towards 0.8 as the 
load capacity of the column falls below the load which produces 'balanced' failure. 
 
On the other hand, at smaller values of e/h (e.g. below 0.5) and relatively small 
slenderness the values of ? system cluster around 0.5. For these columns, failure is by 
primary compression and the capacity reduction factor ?  from AS 3600 is 0.6. 
Furthermore, the effect of slenderness on strength is minimal at Leff/r values of around 20. 
Thus if we reduce the  value of ? system for beams (0.68) by the ratio 0.6/0.8, we obtain a 
value of about 0.5. 
 
On the other hand, with progressively increasing slenderness the ? system  values diverge, 
usually upwards, but for the smallest eccentricities (e/h  ?  0.125) the divergence is 
severely downwards. This reflects the very conservative nature of the AS 3600 moment 
magnification factor method at very small eccentricities and high slenderness. 
 
The increase in calculated values of ? system with increasing slenderness, as shown in Fig 2 
for e/h va1ues of 0.5 and 0.25, requires explanation. It appears that at low slenderness the 
failure mode is in primary compression; however, with increasing slenderness there is 
sufficient lateral bending and outward movement of the central region of the column to 
lead to primary flexure failure and hence to the use of increasing ?  values greater than 
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0.6. This view of column behavior is of course highly simplified and while convenient for 
design, is inaccurate. For example, it can be shown that stability failure can precede local 
section failure in a real column of finite length (Warner et al, 1989). 
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The results shown in Fig 2 allow some preliminary suggestions to be made for values of 
? system . Working from the basic ? system value of 0.68 for ductile continuous beams, a 
smaller value, say 0.5 seems appropriate, for cases where collapse is due to compression 
type failure, and a further reduction, perhaps to 0.4, in cases of high slenderness, where 
stability failure dominates. It is emphasized that these are only indicative figures which 
will have to be confirmed or modified by additional modeling. 

3. EVALUATION OF SYSTEM SAFETY 
COEFFICIENTS OF PORTAL FRAMES BY BACK-
CALIBRATION 

 
In this initial study of safety coefficients for structural frames, attention has been 
concentrated on simple portal frames. It should be noted that frames with ductile strong 
columns and weak beams with uniformly distributed loads acting along the beams fail 
when a plastic collapse mechanism occurs in the beam. For such cases the value of  
? system  = 0.68 can be used for design (Wong and Warner, 1997a). Of interest here are 
frames which may fail by bending in both the beams and columns, and overall instability. 
The portal frames shown in Fig 3 were therefore used in the study, with a horizontal load 
H at floor level and point loads P on the columns, with the ratio H/P varying from 0.1 up 
to 1.5. Both fixed bases (as shown) and pinned bases were considered, with three frame 
heights of 4m, 6m, and 8m for the fixed-base frames; and two frames heights of 4m and 
6m for the pinned-base frames. The slenderness ratios Leff/r for the columns for the fixed-
base frames, calculated in accordance with AS 3600, were 46, 66 and 85; and those for 
the pinned-base frames, 67 and 95. The total amount of reinforcement was 3200 mm2 in 
the cross-section of the columns, with a concrete cover to centroid of steel reinforcement 
of 50 mm. Proportional loading was assumed, with P and H applied simultaneously, 
although a recent study suggests that the results would not be significantly different with 
a non-proportional P-H load sequence (Wong and Warner, 1997c). 
 
For each frame the load capacity Pu,rig was calculated by an accurate nonlinear analysis 
(Wong and Warner, 1997b), and the design ultimate load p* determined in accordance 
with the simplified approach of AS 3600. The system safety coefficient was then 
determined: 

                                                    
rigu

system P
P

.

*
??                                                                  (4) 
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The system safety coefficient values are shown in Tables I and II for the fixed base and 
pinned base frames, respectively, together with the moment magnification factor ? s, used 
in the design of the columns in the frames. The values of ? system are also shown 
graphically in Fig 4 as a function of the load ratio H/ P. 
 
In the case of the fixed base frames, the larger end moments in the columns are in the 
lower ends, next to the fixed-bases.  
 
Hinges formed first in the lower ends of the column followed by the formation of hinges 
next to the ends of the beams. The values of ? system close to 0.68 obtained for the frames is 
due to the formation of the second set of hinges in the beams at the beam column joints 
rather than in the columns, thus limiting the amount of load the frames can carry. The 
formation of the second set of hinges in the beams rather than in the columns reflects the 
strong-column weak-beam design which resulted from the simplified approach of AS 
3600. The system safety coefficients are thus closer to those associated with ductile beam 
failure, rather than the more conservative values associated with column instability 
failure. 
 
There are noticeable increases in safety margin in the three frames with column sections 
having the design strength governed by primary compression failure. The extra 
conservativeness is due to the use of a section strength design reduction factor ?  of 0.6 
for columns which failed by primary compression failure when compared with a value of 
between 0.6 to 0.8 for those which failed by primary tension failure. 
 
The moment magnification factor ? s is also reasonably close to unity for H/P values at 
0.5 and greater in the case of the pinned-base frames, although for some reason the values 
of ? system  are consistently higher than the expected value of 0.68 for H/P values at 0.5 and 
greater. The larger end moments in the columns are next to the connecting beams. 
 
The values of ? s increase markedly as the value of H/P decreases below 0.5. Quite 
unexpectedly the ? system value increases. The frame which satisfies the design requirement 
of AS 3600 and has the least safety margin is the 4m tall frame with H/P = 0.1; it has a 
? system  value of 0.89. This suggests that the current design methods give relatively less 
conservative results for pinned-base portal frames with large moment magnifiers ? s. in 
the columns. 
 
A previous study by Pagay et al (1970) shows that the strength of beams has a 
pronounced effect on the strength of concrete frames, even though some present design 
standards fail to take proper account of this. For example, AS 3600 does not specify any 
requirement for increasing the reinforcement in adjoining beams, to take account of the 
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additional moments transferred from the ends of the columns. Reinforcement in beams is 
incorrectly obtained using the action effects from a linear elastic analysis, assuming gross 
section properties for members. 
 
A reassessment of the system safety coefficients was made for the pinned-based portal 
frame, but with the beams designed to carry the increased bending moment obtained from 
the first-order elastic analysis, magnified by the sway moment magnifier ? s. The system 
safety coefficients obtained are given in Table III and illustrated in Fig 5. All now lie 
close to the value of 0.68. This confirms that the reduced conservativeness was caused by 
the failure of AS 3600 to require an increase in the reinforcement of the beam to 
complement the moment magnification effect acting on slender columns. As observed in 
a previous preliminary study (Wong and Warner, 1997a) on frames, the present study 
confirms that the conservative moment magnifier approach of AS 3600 for the design of 
columns always results in beam failure in the frames. 
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Table I 
 Moment magnifiers and system safety coefficients for fixed-base portal frames 

 
 4m tall portal 6m tall portal 8m tall portal 

H/P ?  s ? system  ?  s ? system  ?  s ? system  
0.05 1.56* 0.51# 1.98* 0.60# 2.37* 0.68 
0.10 1.34 0.53# 1.54* 0.63 1.63* 0.69 
0.20 1.19 0.60 1.24 0.64 1.28 0.67 
0.30 1 .11 0.61 1.14 0.63 1.17 0.67 
0.40 1.08 0.62 1.10 0.63 1.13 0.67 
0.50 1.06 0.63 1.08 0.61 1.10 0.66 
0.60 1.05 0.63 1.06 0.62 1.08 0.66 
0.80 1.04 0.63 1.05 0.63 1.06 0.64 
1.00 1.03 0.61 1.04 0.63 1.05 0.66 
1.50 1.02 0.62 1.02 0.64 1.03 0.66 

note: * exceeds maximum value of 1.50 allowed in AS 3600 
          # primary compression failure in critical column section in simplified         
            design method of AS3600 
 
 

Table II  
Moment magnifiers and system safety coefficients for pinned-base portal frames 

 
 4m tall portal 6m tall portal 

H/P ?  s ? system  ?  s ? system  
0.10 1.47 0.89 1.56* 0.93 
0.20 1'.20 0.78 1.25 0.81 
0.30 1.12 0.76 1.16 0.76 
0.40 1.09 0.73 1 .11 0.73 
0.50 1.07 0.69 1.09 0.72 
0.60 1.06 0.70 1.07 0.71 
0.80 1.04 0.68 1.05 0.69 
1.00 1.03 0.68 1.05 0.69 
1.50 1.02 0.71 1.05 0.69 

note: * exceeds maximum value of 1.50 allowed in AS 3600 
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Table III  
Moment magnifiers and system safety coefficients for pinned-base portal frames with 

increased beam reinforcement 
 

 4m tall portal 6m tall portal 
H/P ?  s ? system  ?  s ? system  
0.10 1.47 0.66 1.56* 0.68 
0.20 1.20 0.67 1.25 0.68 
0.30 1.12 0.68 1.16 0.67 
0.40 1.09 0.68 1.11 0.67 
0.50 1.07 0.66 1.09 0.68 
0.60 1.06 0.67 1.07 0.68 
0.80 1.04 0.64 1.05 0.67 
1.00 1.03 0.67 1.05 0.70 
1.50 1.02 0.70 1.05 0.68 

note: * exceeds maximum value of 1.50 allowed in AS 3600 
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4. CONCLUSIONS 

 
The system safety coefficients obtained for the portal frames analyzed generally gave 
values of approximately 0.68. Several of these portal frames gave larger, and therefore 
less conservative, system safety coefficients. However, this was found to be caused by a 
deficiency in AS 3600 in not magnifying moments in beams connected to slender 
columns. When account is taken of the increased moment in such beams, the system 
safety coefficients of these frames were found to be close to 0.68. 
 
In the extensive study carried out using a back-calibration procedure for pin-ended 
columns the system safety coefficients for columns designed using the simplified 
approach of AS 3600 range from 0.33 to 0.70. On investigation, it was shown that the AS 
3600 simplified design method can give highly conservative results, and this explains the 
exceptionally low values sometimes obtained for ? system. 
The present studies on columns and frames need to be extended. Further work will have 
to be carried out before reliable system safety coefficients can be proposed for the entire 



 34 

range of structures. Nevertheless, appropriate values of ? system for structures with normal 
strength concrete and fsy = 400 MPa reinforcing steel is likely to be: 
 
For ductile flexural systems and flexural collapse mechanisms: 
 ? system  = 0.68 
For isolated columns with small load eccentricities and large slenderness ratios: ? system = 
0.40.  
For frames which fail by loss of stability: ? system= 0.40  
 For systems in which collapse is due to crushing of concrete, such as short axially loaded 
column: ? system = 0.50 

 
In structural systems where the mode of collapse is not due to the formation of a flexural 
collapse mechanism, and the collapse cannot be attributed to the crushing of concrete, the 
more conservative value ? system of 0.40 for instability failure should be used. 
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SECTION III -   A Correlation Study between Ground 
Motion Parameters and Damage 
During Kocaeli Earthquake 
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Abstract: 
 
Traditionally, ground motion parameters, such as peak ground acceleration (pga), 
spectral acceleration (Sa), spectral velocity (Sv), and spectral displacement (Sd), are used 
as a damage indicator during an earthquake. This study is intended to search for a 
meaningful correlation between ground motion parameters and the structural damage 
based on 20 ground motion data from 1999 Kocaeli, Turkey Earthquake. The ground 
motion parameters are computed for both elastic and inelastic SDOF systems at four 
different natural periods; 0.25, 0.50, 0.75, and 1.25 seconds. Furthermore, the inelastic 
SDOF system involved different load deformation models namely bilinear and stiffness 
degrading. Nonlinear dynamic time history analyses are performed on a typ ical 
reinforced concrete frame system of the earthquake region for the 20 ground motion data. 
The damage indices (Park and Ang, 1985) and maximum inter-story drift ratios are 
computed for the frame system at four different natural periods. Finally, correlations are 
found between damage indices and each of the above mentioned ground motion 
parameters. Also correlation coefficients, which proved a well correlation, are calculated 
between damage indices and maximum inter-story drift ratios. 
 
Keywords: Correlation, reinforced concrete frame, ground motion parameters, damage 
index, maximum inter-story drift ratio 
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1. INTRODUCTION 

 
It is well known that there is interdependency between ground motion parameters {such 
as spectral acceleration (Sa), spectral velocity (Sv), spectral displacement (Sd), peak 
ground acceleration (pga), and effective duration} and the structural response. 
Traditionally, the abovementioned ground motion parameters are used as a damage 
indicator during an earthquake. This study helps us to quantify the level of 
interrelationship between the above ground motion parameters and structural damage at a 
reinforced concrete frame system during a ground excitation. 
 
Firstly, 20 ground motion data from Kocaeli, Turkey Earthquake (1999) are chosen. A 
computer analysis is performed and the ground motion parameters are computed for both 
elastic and inelastic SDOF systems at four different natural periods; 0.25, 0.50, 0.75, and 
1.25 seconds. The inelastic SDOF system involved bilinear and stiffness degrading load 
deformation models. After that, nonlinear dynamic time history analyses are performed to 
provide structural response for a typical reinforced concrete frame system of the 
earthquake region. Maximum inter-story drift ratio and Park & Ang damage index (Park 
and Ang, 1985) are computed as damage indices. The attention is focused on structural 
damage, so that the number of the damage indices is limited to only two. Non-structural 
damage is not considered in this study. Finally, correlations are evaluated to express the 
level of interdependency between damage indices and each of the above mentioned 
ground motion parameters. Also correlation coefficients are calculated between damage 
indices and maximum inter-story drift ratios. 
 

2. GROUND MOTION DATA AND PARAMETERS 

 
Ground motion data recorded during Kocaeli Earthquake, as represented in Table 1, are 
used in this study. The peak ground accelerations (pga) are varying between 0.02 and 
0.37g, where g is acceleration due to gravity. The first 14 ground motion data in the 
Table 1 are recorded at rock and stiff soil and the others are recorded at soft soil site. The 
closest distances for the records are varying 5.0 to 183.4 km. 
 
Seismic parameters are chosen as peak ground acceleration (pga), spectral displacement 
(Sd), velocity (Sv), and acceleration (Sa). The effective duration is also computed. The 
effective duration in this study is defined as the duration where ground accelerations are 
over 0.05g in the record. The ground motion (seismic) parameters are computed for both 
elastic and inelastic SDOF systems at four different natural periods; 0.25, 0.50, 0.75, and 
1.25 seconds. Furthermore, the inelastic SDOF system involved different load 
deformation models namely bilinear and stiffness degrading. For the seismic parameters 
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computed for inelastic SDOF systems using the stiffness degrading model, the effect of 
yield strength coefficient and strain hardening are included. The yield strength coefficient 
is defined as yield strength of the oscillator divided by its weight, Fy/W Yield strength 
coefficients are chosen as 0.05 and 0.1 with 0 and 5 percentage of strain hardening (5 
percentage of strain hardening is also included into the analysis for the natural period, 
1.25 seconds). The seismic parameters are computed using bilinear load formation model 
for different ductility levels (ductility ratio=l, 2, 4, 6 and 8) at the natural period, 1.25 
seconds. 
 

3. NONLINEAR TIME HISTORY ANALYSES OF 
R/C FRAME STRUCTURES 

 
Diagram of analyzed 5-story R\C frame structure with typical cross sections and steel 
reinforcements are shown in Figure 1. Nonlinear dynamic time history analyses are 
performed on a typical reinforced concrete frame system of the earthquake region for the 
20 ground motion data for the evaluation of the structural seismic response. The 
computer program, IDARC 4.0 (Reinhorn et a1, 1996) is used for this purpose. The 
hysteretic behavior of the beams and columns has been specified at the ends of the 
members using "Park Hysteretic Model". This model incorporates stiffness degradation, 
strength deterioration, non-symmetric response, slip- lock, and trilinear monotonic 
envelope. The dead, live and seismic loads have been taken into account in design. 
 
All reinforced concrete frame structures consist of three-bay frame, spaced at 800 and 
500 cm. The story height is 450 cm in the first story and 300 cm for other stories. The 
columns are assumed to be fixed to the ground. Yield strength of the steel reinforcements 
is 22 kN/cm2 and compressive strength of concrete is 1.8 kN/cm2. 
 
The natural periods of the frame structure are computed 0.25, 0.50, 0.75 and 1.25 
seconds. The nonlinear analyses are performed for four different frame structures with 
same height and stiffness but different weights. As the modal weights for four frame 
structures are different, their natural periods are found to be different. The cross section 
of all beams is T -shapes with 25 cm width, 12 cm plate thickness, 50 cm total beam 
height and 100 cm effective plate width. The cross section of all columns is 60cmx30cm. 
 

4. DAMAGE INDICES AND CORRELATION OF 
THE RESULTS 
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As damage indices, maximum inter-story drift ratio and overall structural damage index 
(OSDI) are chosen (Park and Ang, 1985). The focus is on overall structural damage 
index, OSDI, because it summarizes all existing damages on the structural components of 
the structure. The damage index is correlated with the seismic parameters, peak ground 
acceleration (pga), effective duration, spectral acceleration (Sa), spectral velocity (Sv), and 
spectral displacement (Sd). The correlation coefficients are presented in Table 2, 3, 4 and 
5. Also correlation coefficients, which proved a well correlation, are calculated between 
overall structural damage index and maximum inter-story drift ratios (Table 2, 3, 4 and 
5). 
 
Park and Ang damage index for a structural element is defined in Equation 1. 
 

                                        ??? h
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where, ?m and ?u are the maximum experienced and the ultimate deformations of the 
element, respectively, Py is the yield strength, ?  is a model constant parameter, and ?Eh is 
the hysteretic energy absorbed by the element during total duration of ground excitation. 
 
To compute overall structural damage index, story damage indices should be calculated. 
The story damage index and overall structural damage index are given in Equation 2 and 
3 respectively. 
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If the overall damage index is found to be larger than 1I, the structure is interpreted as 
collapsed. The structure with a damage index between 0.4 and 1.0 has moderate damage 
and smaller than 0.4 has moderate damage which is repairable. 
 
The correlation coefficients (normalized covariance) and coefficient of determinations, 
R2, are computed to express the level of interdependency between damage indices and 
each of the mentioned ground motion (seismic) parameters. Both correlation coefficients 
and determinations (R2), values are between -1 and 1 and they are the measure of the 
degree of linear relationship between two variables (Ang and Tang, 1976). If the  
correlation coefficient or determination value is close to -1, there is a strong linear 
relationship between the observed data. It should be noted that if the number of observed 
data is large, correlation coefficient will be the same as R2. 
 



 41 

The correlation coefficient values (0.988 to 0.994) in Table 2, 3, 4 and 5 show very 
strong correlations between overall structural damage index and maximum inter-story 
drift ratio. However, overall structural damage index shows poor correlation to peak 
ground acceleration and effective duration in all periods. In Figure 2, correlation of 
determination, R2, values are presented for 1.25 second period structure with SDOF 
system at the same period. Poor correlation between peak ground acceleration and 
effective duration and strong correlation between maximum inter-story drift ratios (ISD) 
with overall structural damage index can be recognized in the Figure 2. For the 0.25 
period frame structure and SDOF system, a better correlation is observed between elastic 
seismic parameters with overall structural damage index for the frame system compared 
to correlation of inelastic seismic parameters and OSDI in Table 2. Similar to results for 
0.25 second period systems, the fair correlation between OSDI elastic seismic parameters 
are observed at the period of 0.50 second (see Table 3). Fair correlation is generally 
recognized between both elastic and inelastic seismic parameters and OSDI at 0.75 
second period (see Table 4). Especially, spectral displacement has the highest correlation 
to OSDI among three seismic parameters in Table 4. At the period of 1.25 second, the 
seismic parameters; spectral displacement and velocity for both elastic and inelastic 
SDOF system have better correlation to OSDI compared to correlation of spectral 
acceleration with OSDI (see Table 5). Finally, the spectral accelerations are computed for 
SDOF system with ductility 1, 2, 4, 6, and 8 at 1.25 second period. The overall structural 
damage index for 1.25 second period frame system is correlated to spectral accelerations 
for different ductility values. Spectral accelerations for higher ductility values (4, 6, and 
8) have strong correlation to OSDI (see Figure 3). 
 

5. CONCLUSIONS 

 
In this study, the level of interrelationship between ground motion (seismic) parameters 
{such as spectral acceleration (Sa), spectral velocity (Sv), spectral displacement (Sd) peak 
ground acceleration (pga), and effective duration} for both elastic and inelastic SDOF 
systems and structural damage  at a reinforced concrete frame system during a ground 
excitation are quantified. Structural damage is represented by overall structural damage 
index (OSDI), and maximum inter-story drift ratio (ISD). 
 
The two structural damage indices OSDI and ISD provide strong correlation to each 
other. However, peak ground acceleration and effective duration correlated poorly to 
OSDI. At the short periods, 0.25 and 0.50 seconds, we observe better correlation between 
elastic seismic parameters with OSDI compared to correlation of inelastic seismic 
parameters and OSDI. At the long periods, the three seismic (ground motion) parameters 
(both elastic and inelastic), Sa, Sv, and Sd, have fair correlation to OSDI. 
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Table 1: Ground Motion data from Kocaeli Earthquake 
 

No Station Record PGA (g) Distance (km) Soil Class 
1 Arcelik Arc- long 0.21 21.6 Stiff Soil 
2 Atakoy Atk090 0.17 67.5 Stiff Soil 
3 Balikesir Blk090 0.02 183.4 Stiff Soil 
4 Botas Bts- long 0.10 136.3 Stiff Soil 
5 Bursa Siv.Savunma Brs- long 0.05 66.6 Stiff Soil 
6 Cekmece Cna- long 0.18 76.0 Stiff Soil 
7 Gebze Gbz000 0.27 13.5 Stiff Soil 
8 Goynuk Gyn000 0.14 35.5 Stiff Soil 
9 Havaalani - Istanbul Dhm-long 0.09 69.3 Stiff Soil 
10 Istanbul Ist- long 0.06 60.7 Stiff Soil 
11 Izmit Izt090 0.23 5.0 Rock 
12 Maslak Msk000 0.05 63.9 Rock 
13 Mecidiyekoy Mcd090 0.07 62.3 Stiff Soil 
14 Zeytinbumu Zyt000 0.12 63.1 Stiff Soil 
15 Ambarli Ats- long 0.25 78.9 Soft Soil 
16 Bursa Bur- long 0.10 62.7 Soft Soil 
17 Fatih Fat-long 0.19 62.2 Soft Soil 
18 Kocamustafapasa KMP000 0.11 62.7 Soft Soil 
19 Iznik IZN090 0.12 29.7 Soft Soil 
20 Duzce DZC270 0.37 12.5 Soft Soil 
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Table 2: Correlation coefficients between damage indices and seismic parameters, 
T=0.25, seconds 

 
 Max ISD (%) PGA Duration 

OSDI 0.988 0.286 0.429 
(Park/Ang)    

 
INELASTIC 

ELASTIC 
Stiffness 

Degrading, 
%0 

Fy/W=0.05 

Stiffness 
Degrading, 

%5 
Fy/W=0.05 

Stiffness 
Degrading, 

%0 
Fy/W=0.l 

Stiffness 
Degrading, 

%5 
Fy/W=0.l 

 

OSDI (Park/Ang) 
Sa 0.752 0.535 0.519 0.522 0.537 
Sv 0.593 0.476 0.498 0.509 0.515 
Sd 0.752 0.503 0.503 0.451 0.464 

 
Table 3: Correlation coefficients between damage indices and seismic parameters, 

T=0.50 seconds 
 

 Max ISD (%) PGA Duration 
OSDI 

(Park/Ang) 0.992 0.263 0.534 

 
INELASTIC 

ELASTIC 
Stiffness 

Degrading, 
%0 

Fy/W=0.05 

Stiffness 
Degrading, 

%5 
Fy/W=0.05 

Stiffness 
Degrading, 

%0 
Fy/W=O.l 

Stiffness 
Degrading, 

%5 
Fy/W=O.l 

 

 OSDI (Park/Ang)  
Sa 0.885 0.773 0.838 0.664 0.774 
Sv 0.913 0.708 0.808 0.786 0.861 
Sd 0.885 0.828 0.835 0.818 0.814 
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Table 4: Correlation coefficients between damage indices and seismic parameters, 
T=0.75 seconds 

 
 Max ISD (%) PGA Duration 

OSDI 
(Park/Ang) 

0.994 0.483 0.440 

 
   INELASTIC  
  Stiffness Stiffness Stiffness Stiffness 
 ELASTIC Degrading, Degrading, Degrading, Degrading, 
  %0 %5 %0 %5 
  Fy/W=0.05 Fy/W=0.05 Fy/W=0.l Fy/W=0.l 
  OSDI (Park/Ang)  
Sa 0.885 0.796 0.924 0.664 0.798 
Sv 0.852 0.635 0.653 0.670 0.790 
Sd 0.885 0.881 0.936 0.978 0.974 
 

 
Table 5: Correlation coefficients between damage indices and seismic parameters, 

T=I.25 seconds 
 

 Max ISD (%) PGA Duration 
0.994 0.421 0.579 OSDI 

(Park/Am!)    
 

INELASTIC 

 
ELASTIC 

Stiffness 
Degrading, 

%0 
Fy/W=0.05 

Stiffness 
Degrading, 

%5 
Fy/W=0.05 

Stiffness 
Degrading, 

%0 
Fy/W=0.l 

Stiffness 
Degrading, 

%5 
Fy/W=0.l 

 

 OSDI (Park/Ang)  
Sa 0.827 0.749 0.853 0.685 0.703 
Sv 0.911 0.829 0.852 0.845 0.843 
Sd 0.827 0.887 0.905 0.880 0.881 
 

INELASTIC 
Stiffness 

Degrading, 
%-5 

Fy/W=0.05 

Stiffness 
Degrading, 

%-5 
Fy/W=0.l 

 

OSDI (Park/Ang) 
Sa 0.841 0.652 
Sv 0.827 0.848 
Sd 0.832 0.877 
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SECTION IV -   Case Study At Gaza – Palestinian 
National Authority 

1. Introduction 

This study is related to frame design with span of 18.0m (one floor) for celebration hall at 
Gaza. 
 
This design was prepared by Samir Manneh by using computer software (ETABS 
Nonlinear Version8.4.5). 
 
This hall was constructed on January 2005. 
 

2. Technical Note for ETABS Nonlinear 
Version8.4.5 

 
This Technical Note presents some basic information and concepts helpful when 
performing concrete frame design using this program. 
 
 

2.1 Design Codes 
 
The design code is set using the Optional Menu > Preferences > Concrete Frame 
Design command.  You can choose to design for any one design code in any one design 
run.  You cannot design some elements for one code and others for a different code in the 
same design run.  You can, however, perform different design runs using different design 
codes without rerunning the analysis. 
 

2.2 Units 
 
For concrete frame design I this program, any set of consistent units can be used for 
input.  Typically, design codes are based on one specific set of units.  The documentation 
in the ACI 318-99 series of Technical Notes is typically presented in kip- inch-seconds 
units. 
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Again, any system of units can be used to define and design a building in this program.  
You can change the system of units that you are using at any time. 
 

2.3 Overwriting the Frame Design Procedure for a Concrete 
Frame 

 
The two design procedures possible for concrete beam design are: 
? Concrete frame design 
? No design 

 
If a line object is assigned a frame section property that has a concrete material property, 
its default design procedure is Concrete Frame Design.  A concrete frame element can be 
switched between the Concrete Frame Design and the “None” design procedure.  Assign 
a concrete frame element the “None” design procedure if you do not want it designed by 
the Concrete Frame Design postprocessor. 
 
Change the default design procedure used for concrete frame elements by selecting the 
element(s) and clicking Design Menu > Overwrite Frame Design Procedure. This 
change is only successful if the design procedure assigned to an element is valid for that 
element. For example, if you select a concrete element and attempt to change the design 
procedure to Steel Frame Design, the program will not allow the change because a 
concrete element cannot be changed to a steel frame element. 
 

2.4 Design Load Combinations 

 
The program creates a number of default design load combinations for shear wall design. 
You can add in your own design load combinations. You can also modify or delete the 
program default load combinations. An unlimited number of design load combinations 
can be specified. 
 
To define a design load combination, simply specify one or more load cases, each with its 
own scale factor. See Technical Notes Design Load Combination Concrete Frame Design 
ACI 318-99, Design Load Combination Concrete Frame Design BS8110-89, Design 
Load Combination Concrete Frame Design.  CSA-A23.3-94, Design Load Combination 
Concrete Frame Design EuroCode2-99,. Design Load Combination Concrete Frame 
NZS3101-95 and Design Load Combination Concrete Frame Design UBC97 for more 
information. 
 

2.5 Design of Beams 

 
The program designs all concrete frame elements designated as beam sections in their 
Frame Section Properties as beams (see Define menu >Frame Sections command and 
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click the Reinforcement button). In the design of concrete beams, in general, the 
program calculates and reports the required areas of steel for flexure and shear based on 
the beam moments, shears, load combina tion factors, and other criteria, which are 
described in detail in Technical Notes Beam Design Concrete Frame ACI 318-99, Beam 
Design Concrete Frame BS 8110-89, Beam Design Concrete Frame CSA-A23.3-94, 
Beam Design Concrete Frame EuroCode2-99, Beam Design Concrete  Frame NZS3101-
95, and Beam Design Concrete Frame UBC97. The reinforcement requirements are 
calculated at each output station along the beam span. 
 
All the beams are designed for major direction flexure and shear only. Effects 
resulting from any axial forces, minor direction bending, and torsion that may exist 
in the beams must be investigated independently by the user. 
 
In designing the flexural reinforcement for the major moment at a particular section of a 
particular beam, the steps involve the determination of the maximum factored moments 
and the determination of the reinforcing steel. The beam section is designed for the 
maximum positive and maximum nega tive factored moment envelopes obtained from all 
of the load combinations. Negative beam moments produce top steel. In such cases, the 
beam is always designed as a rectangular section. Positive beam moments produce 
bottom steel. In such cases, the beam may be designed as a rectangular- or T -beam. For 
the design of flexural reinforcement, the beam is first designed as a singly reinforced 
beam. If the beam section is not adequate, the required compression reinforcement is 
calculated. 
 
In designing the shear reinforcement for a particular beam for a particular set of loading 
combinations at a particular station resulting from the beam major shear, the steps 
involve the determination of the factored shear force, the determination of the shear force 
that can be resisted by concrete, and the determination of the reinforcement steel required 
to carry the balance. 
 

2.6 Design of Columns 
 
The program designs all concrete frame elements designated as column sections in their 
Frame Section Properties as columns (see Define menu >Frame Sections command and 
click the Reinforcement button). In the design of the columns, the program calculates 
the required longitudinal steel, or if the longitudinal steel is specified, the column stress 
condition is reported in terms of a column capacity ratio. The capacity ratio is a factor 
that gives an indication of the stress condition of the column with respect to the capacity 
of the column. The design procedure for reinforced concrete columns involves the 
following steps: 
 

? Generate axial force-biaxial moment interaction surfaces for all of the different 
concrete section types of the model. 

 



 51 

? Check the capacity of each column for the factored axial force and bending 
moments obtained from each load combination at each end of the column. This 
step is also used to calculate the required reinforcement (if none was specified) 
that will produce a capacity ratio of 1.0. 

 
? Design the column shear reinforcement. 

 
The shear reinforcement design procedure for columns is very similar to that for beams, 
except that the effect of the axial force on the concrete shear capacity needs to be 
considered. See Technical Notes Column Design Concrete Frame ACI 318-99, Column 
Design Concrete Frame BS 8110-89, Column Design Concrete Frame CSA-A23.3-94, 
Column Design Concrete Frame EuroCode2-99, Column Design Concrete Frame 
NZS3101-95, and Column Design Concrete Frame UBC97 for more information. 
 

? Beam/Column Flexural Capacity Ratios 
 

When the ACI 318-99 or UBC97 code is selected, the program calculates the ratio of the 
sum of the beam moment capacities to the sum of the column moment capacities at a 
particular joint for a particular column direction, ma jor or minor. The capacities are 
calculated with no reinforcing over strength factor, ? , and including ?  factors. The beam 
capacities are calculated for reversed situations and the maximum summation obtained is 
used. 
 
The moment capacities of beams that frame into the joint in a direction that is not parallel 
to the major or minor direction of the column are resolved along the direction that is 
being investigated and the resolved components are added to the summation. 
 
The column capacity summation includes the column above and the column below the 
joint. For each load combination, the axial force, Pu, in each of the columns is calculated 
from the program analysis load combinations. For each load combination, the moment 
capacity of each column under the influence of the corresponding axial load Pu is then 
determined separately for the major and minor directions of the column, using the 
uniaxial column interaction diagram. The moment capacities of the two columns are 
added to give the capacity summation for the corresponding load combination. The 
maximum capacity summations obtained from all of the load combinations is used for the 
beam/column capacity ratio. 
 
The beam/column flexural capacity ratios are only reported for Special Moment-
Resisting Frames involving seismic design load combinations. 
 
See Beam/Column Flexural Capacity Ratios in Technical Note Joint Design Concrete 
Frame ACI 318-99 or Beam/Column Flexural Capacity Ratios in Technical Note Joint 
Design Concrete Frame UBC97 for more information. 
 



 52 

2.7 Second Order P-Delta Effects 

 
Typically, design codes require that second order P-Delta effects be considered when 
designing concrete frames. The P-Delta effects come from two sources. They are the 
global lateral translation of the frame and the local deformation of elements within the 
frame. 
 
Consider the frame element shown in Figure 1, which is extracted from a story level of a 
larger structure. The overall global translation of this frame element is indicated by ?   . 
The local deformation of the element is shown as ? . The total second order P-Delta 
effects on this frame element are those caused by both ?   and ? . 
 
The program has an option to consider P-Delta effects in the analysis. Controls for 
considering this effect are found using the Analyze menu> Set Analysis Options 
command and then clicking the Set P-Delta Parameters button. When you consider P-
Delta effects in the analysis, the program does a good job of capturing the effect due to 
the ?  deformation shown in Figure 1, but it does not typically capture the effect of the ? 
deformation (unless, in the model, the frame element is broken into multiple pieces over 
its length). 
 
In design codes, consideration of the second order P-Delta an effect is generally achieved 
by computing the flexural design capacity using a formula similar to that shown in 
Equation. 1. 
 

MCAP = aMnt + bMlt                              Eqn.l                                       
where, 
                                            MCAP    = Flexural design capacity 
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Mnt   =required flexural capacity of the member assuming there is no translation of the 
frame (i.e., associated with the ?  deformation in Figure 1) 
 
Mlt  = =Required flexural capacity of the member as a result of lateral translation of the 
frame only (i.e., associated with the ?  deformation in Figure 1) 
 
a=Unitless factor multiplying Mnt 
 
b = Unitless factor multiplying Mlt (assumed equal to 1 by the program; see below) 
 
When the program performs concrete frame design, it assumes that the factor b is equal to 
1 and it uses code-specific formulas to calculate the factor a. That b = 1 assumes that you 
have considered P-Delta effects in the analysis, as previously described. Thus, in general, 
if you are performing concrete frame design in this program, you should consider P-Delta 
effects in the analysis before running the design, 
 

2.8 Element Unsupported Lengths 

 
The column unsupported lengths are required to account for column slenderness effects. 
The program automatically determines these unsupported lengths. They can also be 
overwritten by the user on an element-by-element basis, if desired, using the Design 
menu> Concrete Frame Design> View/Revise Overwrites command. 
 
There are two unsupported lengths to consider. They are L33 and L22, as shown in Figure 
2. These are the lengths between support points of the element in the corresponding 
directions. The length L33 corresponds to instability about the 3-3 axis (major axis), and 
L22 corresponds to instability about the 2-2 axis (minor axis). The Length L22 is also used 
for lateral-tensional buckling caused by major direction bending (i.e., about the 3-3 axis). 
 
In determining the values for L22 and L33 of the elements, the program recognizes various 
aspects of the structure that have an effect on these lengths, such as member connectivity, 
diaphragm constraints and support points. The program automatically locates the element 
support points and evaluates the corresponding unsupported length. 
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It is possible for the unsupported length of a frame element to be evaluated by the 
program as greater than the corresponding element length. For example, assume a column 
has a beam framing into it in one direction, but not the other, at a floor level. In this case, 
the column is assumed to be supported in one direction only at that story level, and its 
unsupported length in the other direction will exceed the story height. 
 

2.9 Analysis Sections and Design Sections 

 
Analysis sections are those section properties used to analyze the model when you click 
the Analyze menu> Run Analysis command. The design section is whatever section has 
most currently been designed and thus designated the current design section. 
Tip: 
It is important to understand the difference between analysis sections and design sections. 
 
It is possible for the last used analysis section and the current design section to be 
different. For example, you may have run your analysis using a W18X35 beam and then 
found in the design that a W16X31 beam worked. In that case, the last used analysis 
section is the W18X35 and the current design section is the W16X31. Before you 
complete the design process, verify that the last used analysis section and the current 
design section are the same. The Design menu> Concrete Frame Design > Verify 
Analysis > Design Section command is useful for this task. 
 
The program keeps track of the analysis section and the design section separately. Note 
the following about analysis and design sections: 
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? Assigning a beam a frame section Property using the Assign menu > Frame/Line > 
Frame Section command assigns the section as both the analysis section and the 
design section. 

 
? Running an analysis using the Analyze menu > Run Analysis command (or its 

associated toolbar button) always sets the analysis section to be the same as the 
current design section. 

 
? Assigning an auto select list to a frame section using the Assign menu > 

Frame/Line > Frame Section command initially sets the design section to be the 
beam with the median weight in the auto select list. 

 
 

? Unlocking a model deletes the design results, but it does not delete or change the 
design section. 

 
? Using the Design menu> Concrete Frame Design > Select Design Combo 

command to change a design load combination deletes the design results, but it does 
not delete or change the design section. 

 
? Using the Define menu > Load Combinations command to change a design load 

combination deletes the design results, but it does not delete or change the design 
section. 

 
? Using the Options menu >  references > Concrete Frame Design command to 

change any of the composite beam design preferences deletes the design results, but 
it does not delete or change the design section. 

 
? Deleting the static nonlinear analysis results also deletes the design results for any 

load combination that includes static nonlinear forces. Typically, static nonlinear 
analysis and design results are deleted when one of the following actions is taken: 

 
? Use the Define menu > Frame Nonlinear Hinge Properties command to 

redefine existing or define-new hinges. 
 

? Use the Define menu > Static Nonlinear / Pushover Cases command to 
redefine existing or define new static nonlinear load cases. 

 
? Use the Assign menu > Frame/Line > Frame Nonlinear Hinges command 

to add or delete hinges. 
 
Again, note that these actions delete only results for load combinations that include static 
nonlinear forces. 
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3. Design Results 

The design results show that, the level of interrelationship between ground motion 
(seismic) parameters such as spectral acceleration, spectral velocity, spectral 
displacement, peak ground acceleration, and effective duration for both elastic and 
inelastic SDOF systems and structural damage at a reinforced concrete frame system 
during a ground excitation are quantified.  
 
 


